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Content of package

WidePIX / WidePIX L Medipix3 device

USB 2.0 cable(s)

+24 V DC adapter

Quick couplings for water cooling

USB memory stick with control software Pixet

Start guide

1.

ok wbd

Connect the device to the water cooling system. Thermal stabilization to 20-25°C is
strongly recommended.

Connect the device to the computer via USB cable(s).

Plug in the power adapter.

Connect the attached USB memory stick to the computer.

Install the device drivers:

o Microsoft Windows: run drivers/setup.exe and follow the instructions.
o macOS: run drivers/D2xxHelper_v2.0.0.pkg.

o Linux: installation of any special drivers is not required.

Install the Pixet application:

o Pixet for Windows is distributed as a single executable file for automatic
installation. Run setup.exe and follow the instructions it the setup wizard.

o Pixet for macOS system is distributed as a standard dmg file (disk image file).
After mounting the pixet.dmg file a window with disk content will open. To install,
move the Pixet folder to the Application folder.

o Pixet for Linux system is distributed as a single tar file. To install, untar the file at
a required location. The application is launched by executing the pixet.sh script.

Run Pixet application. An icon with ID of your device must appear in the left panel.

Default configuration of the connected device is loaded automatically. Configuration
file contains default settings of the detector including calibration of energy
thresholds to keV. Settings of thresholds in keV and bias voltage are shown in the
Detector Settings panel when the configuration is properly loaded. The device is
now ready for use. However, it is advisable not to start any measurements until
the thermal equilibrium is established (~ 20 minutes).

Last detector settings with all your modifications are stored locally on your computer
when Pixet is closed. The settings will be loaded again when starting Pixet with the
same device next time. The defaults can be restored at any time by loading the
default configuration: Click File — Load Config in menu bar and choose the
configuration file using system dialog window. It is located in the Pixet/configs folder
and has .xml extension.
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Understanding the Medipix3 chip operation

Comparison of Medipix and Timepix chips

* Timepix-based detectors allow both the photon counting and spectroscopic “time-
over-threshold” measurement. Medipix-based detectors operate only in the photon
counting mode. However, the radiation spectra can be measured using a threshold
scan.

* Timepix-based detectors have single energy threshold. All energies below the set
value are cut off. Devices are set to a minimal threshold above noise by default.
This is typically 5 keV. The threshold can be adjusted by user in the counting mode.

* Medipix3 detectors have one or more adjustable energy thresholds. The number of
thresholds varies according to the sensor pixel pitch and the mode of operation.
The logic is the same as for Timepix-based detectors; all available thresholds cut off
lower radiation energies. Minimum threshold is typically higher compared to
Timepix-based devices and depends on additional settings.

* Unlike the Timepix-based detectors, the Medipix3 offers several operation modes
for the counting measurement. The list of modes is described in the following
section.

Overview of Medipix3 read-out chip operation

Each pixel of the Medipix3 (MPX3) chip has two thresholds and two 12-bit counters,
which can be alternatively merged to one 24-bit counter, providing enhanced dynamic
range.

In principle, two main modes of operation are available:

1. Single Pixel Mode (SPM): every pixel works independently of its neighbours,
analogous to Timepix-based devices.

2. Charge Summing Mode (CSM): two thresholds are used for the energy
discrimination. The algorithm is as follows: the detected quantum of radiation
generates an electric charge in the sensor. The charge is typically collected to two
or more pixels and creates an electric signal in each pixel. The signal is compared
to the first threshold in every pixel. Signals below the threshold are cut off (similar to
the SPM). The signal/charge of 4 neighbouring pixels is reconstructed (summed)
and assigned to the pixel with the largest charge deposition. The result is then
compared to the second threshold, signals below the threshold are omitted.

The CSM suppresses the effect of charge sharing and the images are sharper in
comparison to the SPM.

Both modes can be moreover operated in several ranges which define the minimal and
maximal achievable threshold. Selection of the range affects also further properties, such
as the energy resolution and stability (noise) of the detector. The range setting can be
found in literature under the term “gain mode”.

ADVACAM s.r.0. www.advacam.com 4



http://www.advacam.com/

WidePIX, WidePIX L MPX3 manual M

Settings of WidePIX MPX3 device (55 pm pixel pitch)

Setting the operation mode and counter depth
Mode of operation can be selected via drop-down list in the Detector Settings panel:

* SPM 1 CH (Single Pixel Mode - one channel). One counter is in use. One energy
threshold (energy channel) is available. Measurement output: one 12-bit or 24-bit
image representing the number of events per pixel.

* SPM 2 CH (Single Pixel Mode - two channels). Two counters are in use. Two
energy thresholds (energy channels) are available. Measurement output: two 12-bit
images representing the number of events per pixel.

* CSM (Charge Summing Mode). Two energy thresholds are in use. Measurement
output: one 12-bit or 24-bit image representing the number of events per pixel.

After changing the operation mode, values of the energy thresholds may change according
to the respective energy calibration.

THLO [keV]: THL1 [keV]: Bias [V]: THL O [keV]: THL 1 [keV]: Bias[V]:

10.1 HAEX: -l [-as0 | 101 2|9 -| |-as0 |
Mode: SPM1CH |

SPM1CH 24 bit [ b3 P

Counter depth is set to 12 bits by default. Check the checkbox in the Detector Settings
panel for the 24-bit depth.

¥ Detector Settings -

THLO [keV]: THL1 [keV]: B s [VI:

10.1 BAEK: £ -as0 |
Mode:

SPM1CH 2abic b3

Setting the range - advanced

Click on the More Detector Settings button in the Detector Settings panel. New window will
appear. Select the range in the drop-down list within the Settings section of the first
Detector tab:

* Broad - the largest threshold range.
* Narrow — better energy resolution at lower energies.

* Super Narrow — very limited threshold range, the best energy resolution at lower
energies, better signal-to-noise ratio.

Note: Super Narrow range is not available with silicon detectors.
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¥ Detector Settings

THL O [keV]: THL 1 [keV]: Bias [V]:

10.1 SIEE 2| 450 |
Mode:
SPM1CH 24 hit b P :
Detector | Chip | Layout | Readout Detector | Chip | Layout | Readout
Information Information
Full Name: WidePIX AD5-W0535-5 Full Name: WidePIX AD5-W0535-5
Device Serial: 189 Device Serial: 189
Chip Type: Medipix3 RX Chip Type: Medipix3 RX
Calibration: No hd Calibration: No -
Settings Settings
Range (Gain mode): Broad (SLGM) - Range (Gain mode):
) ) Broad (SLGM)
Continuous Mode Continuous Mode
Super Narrow (SHGM)
Custom Settings Custom Settings
Counter: Counter 0 - Counter: Counter 0 b
Counter Depth: 12 bits - Counter Depth: 12 bits -
Colum Block: All - Colum Block: ' All -
o
Row Block: All v Row Block: All v
CSM Equalize CSM Equalize
Color Mode Disc Csm Spm Color Mode Disc Csm Spm
Cancel OK Cancel OK

Click OK to confirm the changes.

Note: the Custom Settings section is intended for expert users only. Any modification
of Custom Settings section may lead to unpredictable behavior of the device!

Useful tips and how-tos

Pixet Pro is being developed in Advacam s.r.0. as desktop application for expert users. It
implements full control of the Timepix- / Medipix-based detectors and it is used within
manufacturing processes (testing, calibration, ...) as well as during the preceding
development phase of the devices. Since the application is very powerful, inexperienced
user could set the device to non-functioning state. Recovery from such case is loading the
factory settings shipped with the detector.

Here are several tips for more effective and comfortable use:

» Composition of panels on the right side of the Pixet window can be configured in
Panels in menu bar.

* Orientation of the image (rotation, mirroring) can be customized in View drop-down
list in menu bar.
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File Panels Tools Help
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il Show Grid Ctrl+G
Show Masked Pixels Ctrl+M

Ensure Aspect Ratio Ctrl+a

* To keep the aspect ratio of the image click on View — Ensure Aspect Ratio in menu
bar.

» Default colormap is gray. Colormap can be selected via drop-down list under the
multicolored icon located in main toolbar.

File View Panels Tools Help
IR O W 2O e 3 =z =
—_— S
AOSWOS3S5 [ o5 |I_:|| Gray

o I
1 Jet White -
B Hot
™ cool
[ HsL

@ cool Warm

[ inverted Gray

* Image Properties panel allows to adjust brightness and contrast of the displayed
images by setting the range to be displayed. Auto range option provides automatic
adjustment.

* Advanced Image Properties panel allows to set gamma correction for better
visibility of features within measured sample.

* Pixet allows opening and showing previously saved images by drag and drop into
image area of the Pixet window. When multiple images are drag and dropped, one
can browse them using blue arrows in the main toolbar.

File VWiew Panels Tools Help
fp—

ADS-WO535-5

()

e BEHE Oy = €1 | =W B AL [
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Images can be zoomed by holding the left mouse button in the frame, dragging the
mouse to create a selection rectangle and releasing the mouse button. To restore
the original frame size, double click on the image.

Application output including error messages are shown in Messages panel.

File View Panels Tools Help

O E BEE@E gz = @2 £ A License: Advacam Internal B

Min: :[J | Max: |198 |

Auto range: Min-Max -
Type: Count: Time [s]:
1 X (column number) 1280 | Frames ¥ | |2 “l |
I, s e
0 2.5e+07 5e+07 7.5e+07 1e+08 Repeat File output &

Messages

¥

(15:29:40.189) Setting DACs failed (Cannot set DACs (chan=0, chip=0): Sending of command failed. Error: -1 (usb bulk write failed).) -
(15:29:40.205) WidePLX A05-W0535-5: Cannot send OMR (Sending of command failed. Error: -1 {ush bulk write failed).)

(15:29:40.220) WidePLX A05-W0535-5: Cannot set DACs (chan=0, chip=0): Sending of command failed. Error: -1 (usb bulk write failed)

(15:29:40.235) Setting DACs failed (Cannot set DACs (chan=0, chip=0): Sending of command failed. Error: -1 {ush bulk write failed).)

(15:29:40.252) WidePLX A05-W0535-5: Cannot send OMR (Sending of command failed. Error: -1 (usb bulk write failed).)

(15:29:40.267) WidePIX AD5-W0535-5: Cannot write matrix (chan=0, counter=1).
(
(
(
(

[E open when new message

15:29:40.276) Cannot set pixel configuration (Cannot write matrix (chan=0, counter=1).)

15:29:40.283) WidePLX AD5-W0535-5: Cannot send OMR (Sending of command failed. Error: -1 (usb bulk write failed).)
15:29:40.289) WidePIX A05-W0535-5: Cannot set DACs (chan=0, chip=0): Sending of command failed. Error: -1 (usb bulk write failed).
15:29:40.295) Setting DACs failed (Cannot set DACs (chan=0, chip=0): Sending of command failed. Error: -1 (usb bulk write failed).)
(15:29:40.300) Cannot refresh DACs (Cannot set DACs (chan=0, chip=0): Sending of command failed. Error: -1 {usb bulk write failed).)

%) DAC Panel T:0:00:04.1 | R:1/2 | Ac2/2 | ®

FPS:0.2

In case of hardware disconnection, the device can be reconnected by clicking File —
Reconnect in menu bar without restarting Pixet application.
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Practical examples of measurements

1. Measurement in SPM using one threshold

Setting of the detector on Detector Settings panel
* Set the device to SPM 1 CH operation mode as described above.
» Switch on / off the 24-bit counter depth as described above (optional).

» Set first threshold THL 0 [keV] to desired value. Second threshold THL 1 [keV] is
not in use for this operation mode.

¥ _Detector Settings

THL 0 [keV]: \JHL 1 [keV]: Bias [V]:

10.1 “ oo 2| |-as0 |
Ea——— -

SPM1CH + 2abic W b

Controlling the measurement parameters via Measurement panel
» Select type of measurement in Type drop-down list. There are three options:
o For single acquisition select Frames and set parameter Count to 1.

o Integral — several acquisitions are added to one frame. Number of acquisitions
to be added is defined by parameter Count.

o Test Pulses — for service use only.

» Set the exposure time of individual frame acquisitions in seconds using Time [s] text
box.

* Checking the Repeat checkbox and setting the number of repetitions using the text
box underneath will cause repeating the defined measurement several times.
Setting the number of repetitions to zero value means “repeat forever”. If the
Repeat checkbox is unchecked, the number of repetitions is not in use.

Type: Count: Time [s]:
Frames | |100 o |
Repeat File output &a3
0
@) start

Note: In case of combining Repeat and Frames, it is advisable to set the Count
parameter to value greater than 1, especially for acquisition times shorter than 1 s.
This prevents from unwanted increase of measurement dead time.

Starting the measurement

Start / stop the measurement using Start / Stop button on the Measurement panel.
Progress of the measurement is shown in the status bar at the bottom of the window.

Once the measurement is finished, the measured frame is shown in the image preview
area of the Pixet window.

ADVACAM s.r.0. www.advacam.com 9
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Automatic saving of measured data

Check File output in Measurement panel for automatic saving. Then click on the button
with three dots. A system dialog window will appear to Select the target destination and
filename. Confirm it by clicking the Save button. Measured data are saved automatically
during the measurement. A warning dialog will appear if the file name and destination is
used for another measurement.

¥ Measurement

Type: Count: Time [s]:

Frames «||100 Sfor |

Repeat File output 4oz
@ start

Two files are saved by default to each frame:
* data file (.txt)

» description file (.dsc) which contains information about the device, used
configuration, measurement settings, etc.

Manual saving of measured data

Click on Save Measured Data option in View drop-down list in menu bar. A system dialog
window will appear. Select the target destination and filename and confirm by clicking the
Save button. All frames within the sequence defined by the Count parameter are saved.

Save Current Frame option in View drop-down list in menu bar will save the last frame
only. Option Save All Frames is similar to the Save Measured Data in this case.

View Panels Tools Help

Open Frame... =

I

led save current Frame ...

N
A3
led save All Frames...

Load Config...
Save Config...

Load Factory Config

Reconnect

2. Measurement in SPM using two thresholds

Setup of the detector in Detector Settings panel
* Set the device to SPM 2 CH operation mode as described above.

» 24-bit counter depth is not available.

ADVACAM s.r.0. www.advacam.com 10
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» Set both thresholds THL 0 [keV], THL 1 [keV] to desired values. Second threshold
should be higher than the first threshold.

* Detector Settings
THL O [keV]: THL 1 [keV]: Big

> log

10.1
ModeEr

SPM1CH + 2abic P

Controlling the measurement parameters via Measurement panel
See example 1.

Starting the measurement
See example 1.

Once the measurement is finished, the measured frames are shown in the image preview
area of the Pixet window. Use buttons at the image area bottom to switch between the
energy channels.

File View Panels Tools Help

= 5 B O E O = & |1 = |G| B e [ License: Advacam Internal
[ — -}

AOS-WOS35-5 ¥ Image Properties

Min: |[J | Max: |:198 |

[——— !

Auto range: Min-Max >

¥ Measurement

Type: Count: Time [s]:

Frames | |1 2[ {1

Repeat [E File output 83

: ¥ (column number) N . |7| -

0 2.5e+07 5e+07 7.5e+07 1e+08 @ Start

~ Detector Settings

THLO [keV]: THL 1 [keV]: Bias [V]:

e 2| [4s0
Mode:

|1HL{J ||w| Iy SPM2CH 24 bit b

MessagestACPanel_’ FPS:0.0 | T: 0:00:03.1 | R:1/0 | A:1/1 | ®

Automatic saving of measured data
See example 1.
Six files are saved by default:

ADVACAM s.r.0. www.advacam.com 11
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+ data file (.txt) for first channel with ending “_THLO”

» description file (.dsc) for first channel with ending “_THLO”

» data file (.txt) for second channel with ending “_ THL1”

» description file (.dsc) for second channel with ending “_ THL1”

* data file (.txt) combining both channels — for service use.

» description file (.dsc) combining both channels — for service use.

How to save measured data manually

Click Save Measured Data option in View drop-down list in the menu bar. A system dialog
window will appear. Select the target destination and filename and confirm it by clicking the
Save button. All frames within the sequence defined by the Count parameter are saved for
both channels.

Click Save All Frames to save the entire frame sequence of the selected channel only.

Click Save Current Frame option in View drop-down list in menu bar to save the last frame
of the selected channel only.

3. Measurement in CSM

Setting of the detector on Detector Settings panel
* Set the device to CSM operation mode as described above.
» Switch on / off the 24-bit counter depth as described above (optional).

» Set both thresholds THL 0 [keV], THL 1 [keV] to desired values. Second threshold
should be higher than first threshold.

THL O [keV]: THL 1 [keV]: Bigs [V]:

10.1 o0 | Lo |
Mode:

SPM1CH w 24 hit h P

Controlling the measurement parameters via Measurement panel
See example 1.

Starting the measurement
See example 1.

Automatic saving of measured data
See example 1.

How to save measured data manually
See example 1.

ADVACAM s.r.0. www.advacam.com 12
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4. Measurement in Time Delay Integration regime

The time delay integration (TDI) is implemented for WidePIX 1x5, WidePIX L 1xN (N = 5,
10, 15, ...) devices. TDI can be used for continuous scanning where for example samples
move on a conveyor belt along the detector.

Setting up the Time Delay Integration regime

To switch on / off this functionality click on More Measurement Settings button in the
Measurement panel. New window will appear. Then check / uncheck Time Delayed
Integration (TDI) checkbox in the Advanced Measurement Settings section on the first tab
General. Confirm the change by clicking OK.

¥ Measurement

Type: Count: Time [s]: General | File Qutput
TR = |L| Advance Measurement Settings
Repeat File output 5] Delay after repeat [s]: 0.000
0 B Spacing: 1
@ Start Refresh DACs before measurement

Refresh Pixel Cfg. before measurement
[E Time Delayed Integraticuh[TDI)

[E Sensor Refresh

Trigger Settings

Mo Trigger v
Test Pulses Settings
Pulse count (1 - 1000) 100 -
Pulse period (1 - 236) [us] 1.00 b

Pulse Charge1 (0 - 1e+04) [V] |0.50

Pulse ChargeZ (0 - 1e+04) [V] |0.50

Manual TP Bits

Cancel oK

All operation modes, bit depths and ranges of static measurement (as described in
previoew section) are implemented also in TDI.

Alignment of the experiment

Sample to be measured has to move along the detector. Movement of the sample with
respect to the WidePIX device must be in the sense from the top to the image bottom (i.e.
towards the device readout peripheries; by default the image in Pixet is oriented with
peripheries at the bottom).

Basic settings

Set the operation mode, counter depth and energy threshold(s) as desired. Switch on the
TDI regime as described above.

ADVACAM s.r.0. www.advacam.com 13
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Measurement panel
* Set the Type of measurement to Frames.
» Set number of frames into Count.
* Enable repeating and set number of repeats.

* Set acquisition time Time [s] corresponding to the movement of the sample by chip
size (dead time for the chip read-out should be included). The chip size is
256x0.055=14.08 mm. Hence, the exposure time corresponds to the speed the
sample moves along this distance. To achieve a perfect synchronization the time
can be optimized by evaluation of the object sharpness.

Automatic saving of measured data
See example 1.

How to save measured data manually
See example 1.
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Advanced control using Python Scripting plugin

Python Scripting plugin allows the user to perform complex measurements controlling the
detectors automatically via Python commands and scripts. The Python Scripting embeds a
full python 2.7 interpreter including the standard python libraries. All standard functionality
of python is threfore accessible. Please refer to www.python.org or www.learnpython.org
for more information about Python programming language.

Click on the icon on the right edge of the main toolbar to start the Python Scripting plugin.
Choose Python Scripting from the list. A new window with simple editor will open. The
bottom part of the plugin window contains a python console, where python commands can
be run one by one with immediate output. The console also contains the output of
executed python script.

File View Panels Tools Help

| = B 0 & Qv = = 0 (7] B2 e [ License: Advacam Internal |«
= G i M
DO9-WO535-15 DAC Scans
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Quit
R s —
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n 10238 20475 N7z AN950
SPM1CH = 24 bit b

Apply Filter

Flat-Field v | & @@

¥ Image Info
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cCooooo
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File  Script  Help

e B 4

MPX3_adjustment MPX3_example Untitled.py EJ

1|

The Pixet API (Application Programming Interface) is accessible in the scripts via a pixet
variable. This variable represents the IPixet object that provides all the necessary
methods to get information about all connected devices, log messages to log file, access
the Pixet menu, etc. A list of all available objects, methods and constants of the Pixet API
can be displayed by clicking Help — Function List... in the main menu of the Python
Scripting window.

1. Sample script #1
Detector settings (operation mode, counter depth, range, threshold), simple acquisition

# get list of all connected Medipix3 devices
devices = pixet.devicesByType (pixet.PX_ DEVTYPE_MPX3)

# get first device from list
dev = devices[0] # returns IDevMpx3 object

# set operation mode
dev.setOperationMode (pixet .PX_MPX3_OPM_SPM 1CH)

# SPM 1 CH: pixet.PX MPX3_OPM SPM 1CH (0)

# SPM 2 CH: pixet.PX MPX3_OPM SPM 2CH (1)

ADVACAM s.r.0. www.advacam.com 16
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\e

# CSM: pixet .PX MPX3_ OPM CSM (2)

# get operation mode
print ('Operation mode:

+ str (dev.operationMode ()))

ADVACAM s.r.0.

www.advacam.com
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# set counter depth
dev.setCounterDepth (pixet .PX_MPX3_CNTD_24B)

# 12 bits: pixet.PX_MPX3_CNTD_12B (2)
# 24 bits: pixet.PX_MPX3_CNTD_24B (3)

# get counter depth
print ('Counter depth: ' + str(dev.counterDepth()))

# set range
dev.setGain (pixet .PX_MPX3_GAIN_SUPERHIGH)

# Super Narrow: pixet.PX_MPX3_GAIN_SUPERHIGH (0)

# Narrow: pixet .PX_MPX3_GAIN_HIGH (1)
# Broad: pixet .PX_MPX3_GAIN_SUPERLOW (3)
# set threshold

th_index = pixet.PX_MPX3_THO # index of threshold to be changed
# THL 0: pixet.PX_MPX3_THO (0)
# THL 1: pixet.PX_ MPX3_TH1 (1)

chip = 4 # chip index (chips are counted from 0!)
# chip #1: 0
# chip #5: 4

# all chips: pixet.PX_CHIP_ALL (-1)
th_energy = 30 # new value of threshold in keV

dev.setThreshold (chip, th_index, th_energy, pixet.PX THLFLG_ENERGY)

# acquisition
acqgCount = 1 # number of acquisitions
acgTime = 10 # time of acquisition in seconds

dev.doSimpleAcquisition (acgCount, acqTime, pixet.PX_ FTYPE_NONE,

# get last acquired image
frame = dev.lastAcgFrameRefInc ()

data = frame.data()

ll)

2. Sample script #2
Integral acquisition, saving the data

# get first device from list of all connected Medipix3 devices
dev = pixet.devicesByType (pixet.PX_ DEVTYPE_MPX3) [0]

# set operation mode
dev.setOperationMode (pixet .PX_MPX3_OPM_SPM 2CH)

ADVACAM s.r.0. www.advacam.com
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# set acquisition parameters

acgCount = 10 # number of acquisitions for integral measurement
acqgTime = 0.1 # time of one acquisition
fileName = './test/image.txt'

# integral acquisition, saving
dev.doSimpleIntegralAcquisition (acqCount, acqgTime, pixet.PX FTYPE_AUTODETECT,

fileName) # data are automatically saved

3. Sample script #3
Threshold scan

# get first device from list of all connected Medipix3 devices
dev = pixet.devicesByType (pixet.PX_DEVTYPE_MPX3) [0]

# set operation mode
dev.setOperationMode (pixet .PX_MPX3_OPM_CSM)

# set acquisition parameters
th = pixet.PX MPX3_TH1 # index of threshold to be changed

ths = range(10,45,5) # thresholds in keV
acqgCounts = [1 for number in ths]

acqgTimes = [0.1 for number in ths]

output = './test_' # destination path

# threshold scan
for i in range(len(ths)):
print ('TH: {}'.format (ths[i]))
dev.setThreshold (pixet.PX CHIP_ALL, th, ths[i], pixet.PX_ THLFLG_ENERGY)

fileName = output + str(ths[i]).zfill(3) + 'keV.txt'

dev.doSimpleIntegralAcquisition (acqgCounts[i], acqgTimes([i],

pixet.PX FTYPE AUTODETECT, fileName)
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